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CHAPTER 1
INTRODUCTION

Product Overview

Developed with understanding of compensable transaction and formal verification, NOVA
WorkFlow is an innovative workflow modeling framework based on the Compensable Workflow
Modeling Language (CWML)*, a formal graphical language proposed by CLI. The framework
consists of a graphical editor, a translator and a workflow engine.

The graphical editor provides visual modeling of workflow which ensures correctness by
construction. The editor is developed as an Eclipse RCP plug—inz, so you can make use of many
Ul features provided by Eclipse and install the editor in different OS platform.

The translator can automatically translate a workflow model to a model in the input language
of a model checker3. After building a model using our editor, you only needs to click on a action
button and will obtain a translated model for simulation and verification in the model checker.
As workflow models in reality can be rather huge and complicated, resulting in unbearable long
verification time, the translator incorporates a model reduction algorithm accelerate the
verification time while maintaining the equivalence of the original model and the reduced one.

The workflow engine let you execute the verified workflow model built using the editor. The
engine is developed using popular Spring (http://www.springsource.org) and Hibernate

(http://hibernate.org) framework with a good understanding of current J2EE framework. The

workflow engine can run in different platform with various database and web application
servers.

! For details on CWML, please refer to Fazle Rabbi, Hao Wang and Wendy MacCaull. "Compensable WorkFlow Net". The 12th
International Conference on Formal Engineering Methods (ICFEM 2010).

2 Eclipse, a popular and powerful Java IDE, is architected so that its components could be used to build
just about any client application. The minimal set of plug-ins needed to build a rich client application is
collectively known as the Rich Client Platform (RCP).

® Currently we use the model checker DiVinE (http://divine.fi.muni.cz/), The framework will provide

support to other model checkers in the near future.
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How to install

Product Requirements
Operating system (any one)
v" SUN Solaris 2.6, 7, 8, 9 or 10[sparc]
v’ Linux- Red Hat Enterprise Linux/Fedora, Debian etc
v" Windows 2000/2003 Server, Advanced Server
v" Windows 2000/XP/Vista/2007
Application Server (any one)
v' BEA Weblogic Server 8.1/9
v’ Resin 3.0.x
v Apache Tomcat 5.0.x
Database Server (any one)
v’ Oracle 9i Release 9.2
v' MysSQL 5
v Sybase 12.5 or higher
v' PostgreSQL 8
Java Devleopment Kit
v' SUNJDK 1.5
Model Checker
v DiVinE
Open source software’s

v Spring Framework 1.2
8|Page
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v' Hibernate 3.5.4
v Eclipse Galileo 3.5
Starting the installation

Download and install Sun JDK 1.5 from http://java.sun.com and Eclipse Galileo from

http://www.eclipse.org . Download NOVA Workflow plugin ca.stfx.logic.novawf.jar from

http://logic.stfx.ca/novaworkflow and paste under eclipse/plugins directory.

Create a project

Open Eclipse and create a Java Project. Create a library folder named ‘/ib” in your project.
Download cwf.jar from http://logic.stfx.ca/novaworkflow and paste it into ‘/ib’ directory. Add

cwf.jar into your Build Path.

What you will see £ Package Explorer &3 Tg Hierarchy =
& | e

4 == healthcare
e
- =, JRE System Library [JavaSE-1.6]
4 =i, Referenced Libraries
o cwf.jar
4 = lib
2 owfjar

Figl.1: Directory Structure of Java Project
Create a Workflow model

Create a package in your source (src) directory where you want to store your workflow models.
Right click on your package and select New -> Example. Select ‘New Workflow’ wizard and click
next. You will see ‘Create New Workflow’ Wizard. Enter the name of the workflow (file
extension .cwf), author name. Select additional attributes for the workflow from drop down list.
Attributes are described in the following table:
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Tablel.1 Workflow attributes

Attribute Value

Description

Root Net True

During execution, a workflow with Root Net = True will start first. There can
be only one workflow with Root Net = True in your workflow package.

False

A workflow with Root Net = False is a subnet. A subnet can be decomposed
by a composite task. During execution of a composite task, it is unfolded to

a subnet

True True

Compensable

A True compensable workflow can hold only compensable tasks. A
compensable task can only be decomposed to a True compensable

workflow.

False

A workflow with True Compensable = False can hold both compensable and
uncompensable task. An uncompensable task can only be decomposed to

this workflow.

What you will see

Create New Workflow

This wizard creates a new workflow file with *.cwf extension,

Browse...

Container: Shealthcare/src/pc
File name: Owerall.cwf
Author;

Boot net

True compensable |False -

Cancel J

Figl.2: Create New Workflow Wizard

Click Finish to create your first workflow model. An empty workflow model will open in the
editor pane with an Input Condition and an Output Condition.

10| Page
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What you Wi" see Java —healﬂ\cre/srcfpc;'(}verall.— Eclipse Plaorm
File Edit Mavigate Search Project Run Window Help

M- $-0-Q- BE G- &S F~ §-5 -

{2 Package Explorer &2 'E: Hierarchy| = O || ) Overall.cwf &3
T

=
B healthcare
8 src
£ pe

“3 Overall.owf
B\ JRE Systemn Library [JavaSE-1.6] ( } (i}
=i, Referenced Libraries
g cwfjar

= lib
=i owf.ar

Figl.3: Workflow Editor
Workflow Components View

To edit the workflow, open Workflow Components View. Workflow Components view can be
found from Window->Show View-> Other -> CWML. You can also use the Outline view to get
an outline of your workflow components.

Where you will find 2 Show View = | B

type filter text

- = General -
. = Ant [
- [= APl Tooling
- = VS
4 [= CWML
“) Workflow Components
. = Debug
. = Help
. = Java
. [= Java Browsing

e

. = Plug-in Development
. == Tasks

T Teams

-

Use F2 to display the description for a selected view.

T | ro—

Figl.4: Open Workflow Components View
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Figl.5 shows the Workflow Components View. Using the tools you can easily edit your

workflow.
What you will see “) Workflow Components &3 =8
e VhdeReEd”
—{ I+ Atomic Task
Ml Compensable Task 17
‘%I Bacloward Handler
&

Figl.5: Workflow Components View
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CHAPTER 2
USING THE EDITOR

NOVA Workflow comes with a graphical editor for workflow modeling. The workflow you will
make using this editor will be a structured workflow. The workflow model is stored in xml
format.

Insert an atomic task

To insert an atomic task in your workflow model use Pre-Selection and Post-Selection tools. The
tools are available in Workflow Components View.

Where you will find

Post-Selection tool

| o

“) Worlflow Components 22

& " = mﬁ&zaﬂ
—{ I+ Atomic Task

=
-~

Pre-Selection tool

#ME* Compensable Task

Fig2.1: Pre-Selection and Post-Selection tool

The Pre-Selection tool will change the color of a node to Green and Post-Selection tool will
change the color of a node to Blue. After selecting two nodes by Pre-Selection and Post-
Selection, double click on Atomic Task from the Task list of Workflow Components.

13| Page NOVA WorkFlow 0.1
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What you will see ) *Overall.owf &%

o——L ]
TASK 3

Fig2.2: Insert an Atomic Task

Insert a split-join block

To insert a split-join block use the Pre-Selection and Post-Selection tool as before. Select two
nodes where you want to insert your block, and then double click on the split-join block from
Workflow Components.

“) *Overall.owf &3

O
S
TASK 3 SPLIT

Fig2.3: Insert a Split-Join block

What you will see

TASK 5

]

TASK 6

You can insert AND, XOR, OR, Parallel Composition, Internal Choice, Alternative Choice,
Speculative Choice block in the same way.
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You cannot insert an uncompensable task or block inside a compensable
block. If you try to insert, you will get an Error message “Invalid Selection:
You cannot insert uncompensable task inside Compensable block”.

Increase number of branches of Split-Join block

You can insert a new branch to a split-join block with an atomic task or another split-join block.
To do this select the Split task of the block by Pre-Selection and the Join task by Post-Selection
and double click on the task that you want to insert in a new branch from Workflow
Components View.

What you will see ~
TASK_S
— > > —
SPLIT TASK_6 17
TASK_8

Fig2.4: Insert atomic task in a new branch

Insert a Loop

To insert a loop around some tasks select two nodes using Pre-Selection and Post-Selection.
Double click on Loop from Workflow Components list.
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What you will see

O —®

LOOP 6 TASK 3 TASK 4 LOOPCS

Fig2.5: Insert a Loop

To insert a loop around a single atomic task, select the atomic task twice-
first by Pre-Selection tool and then again by Post-Selection tool.

Add an Error Handler

An error handler (Backward/Forward) can be added to a Compensable task. Select the
Compensable task by Pre-Selection tool and double click on the Error-Handler from Workflow
Components view.

What you will see -
E
Bck 5
O— i« —@®
TASK 3 TASK 4

Fig2.6: Add an error handler
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Add a Programmable Compensation

To add a Programmable Compensation to a Compensable task, select the task by Pre-Selection
tool, and double click on Programmable Compensation from Workflow Components.

What you will see /
p—_i “ - » “ ||
Taskhy spl_rr_ii\
¥
=
-
PROG 6

Fig2.6: Add a Programmable Compensation

Edit a task

To edit a task, select it and then click on the Task Property Settings tool from Workflow

Components View.

Where you will find “) Workflow Components &3 = 0O
ﬁaiQmmE@ﬂé%v

Task Property Settings

—{ = A

(¥l Compensable Task

m

Fig2.7: Task Property Settings

This will open a Task Property dialog where you can edit task name, description, author name.
There is a check box for creating Property file; this will be described in the next Chapter.

17 |Page NOVA WorkFlow 0.1
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What you will see = = | B
Task Froperties 2
o
Create or update your task properties
-
Task Name: Admission
Description:
Author; Rabbi
Create Property File: [
@_‘) [ Finish J [ Cancel

Fig2.8: Task Property Settings

Delete a task
To delete a task or a split-join block, select the task by Pre-Selection tool, and then click on the
delete tool from Workflow Components View. If you select a split task and click this tool, this

will delete the whole block (split, join and all of its branches).

“Y Workflow Components 3 = O

& % ﬂ‘aﬁ“fﬁ[&b(--)v

[ Delete Selected Taszk ]

Where you will find

— = Atomic Task

—{#l® Compensable Task

Fig2.9: Delete task tool

18| Page NOVA WorkFlow 0.1



Make Composite Task

()] NOVA

WorkKFlow

Select the task (Atomic or Compensable) you want to make composite, and then click on the
Make Composite tool from Workflow Components view. A Subnet workflow selection dialog

will open from where you can assign the subnet.

Where you will find

What you will see

19| Page

“) Workflow Components &3 = 0O

& e mms@x(—év
Make C sit

—{ = Atomic Task I ki 1 I.E—.!

#Ml? Compensable Task

Fig2.10: Make Composite tool

C

Assign Subnet workflow to your composite task

(@ Anuncompensable task can be decomposed to any subnet, but a
compensable task can only be decomposed to a true compensable net.

Select Workflow

o Cverall
@/‘ InformationSharing

—— | ——

Fig2.11: Subnet Workflow Selection Dialog

If you select a Compensable task to make it composite, you will only see
Subnet workflows with True Compensable = True.

NOVA WorkFlow 0.1
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CHAPTER 3

USING THE TRANSLATOR FOR
FORMAL VERIFICATION

NOVA WorkFlow incorporates a translator which translates the workflow model to a model in
the input language for a model checker. Current version translates the workflow model to
DiVinE model checker. One important feature of our translator is that it translates data fields in
the model and provides data-abstraction capabilities for complex data types.

Supported Data types

For application development you can use any java data type. You can use Class, List, Vector, and
Aggregate Class also. But for the verification you can only take byte, integer, long and boolean,
although these data types can be specified inside a Class/List/Vector/Aggregate Class. String,
Float and Double are not supported as they are not supported by the model checker. NOVA
WorkFlow encourages you to make your entities object oriented.

All the entities/properties of your application might not be important for
verification. For example Patient’s name is not an interesting property
that guides the flow, so you can simply ignore this property for

verification.

Fig3.1 shows one simple entity bean that you can use in NOVA WorkFlow. If you are using
Hibernate for your application development your entities will be a POJO (Plain Old Java Obiject).

20| Page NOVA WorkFlow 0.1
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nixlic clas=z ReferralInfoDT{ extends PersistantCapableDTO {
Example o F

private static final long serislVersionUID = 1L:

private S5tring patientMName;

private S5tring referralName:

private String phoneNumber;

private Addres=s address;

private List<ContactPerson»> contacts;
private int admissionDecizion:
private int age;

poblic String getPatientName () {
retorn patientMName;

Fig3.1: Entity Bean

NOVA WorkFlow provides a base class named PersistantCapableDTO for
entity beans and some abstract classes for Data Access Objects. There is
no restriction to use PersistantCapableDTO, and you can ignore them.

Tips,

Create Task Property File

When you have all your data-types defined as entity beans, you need to create task property
files. In this property file, you can write statements that will be translated to the input language
of model checker. To create a task property file, select a task and click on Task Property
Settings tool from workflow components (see Fig2.7). Select the checkbox Create Property File
and click Finish. A Java class with the task name will be created under a package named with
the workflow name. Depending on the type of the task you selected, the generated class will
extend different abstract classes. The abstract class has some abstract method that you have to
implement. Fig3.2 shows an example property file of an atomic task.
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& Java - healthcare/src/pc/Overall/ReceiveReferral java - Eclipse Platform

File Edit Source Refactor MNavigate Search Project Run  Window Help

M-EH i $-0-Q- 8H# G- @+ POAvEND  H-5-%6-
[% Package Explor 2 Tg Hierarchy| = 8 || [J] ReferrallnfoDTO java
B%(e”

{35 healthcare
G src
B pe
|=] cwf.property
) InformationSharing.cwf
“Y Overall.owf
“) Registration.cwf
1 pc.entity
ReferrallnfoDTO java
i pc.Overall
1] ReceiveReferral java
= JRE System Library [JavaSE-1.6]
=i Refaramrad | ihrarias

Y Overall.owf
package pc.Overall;

@®import ca.stfx.logic.cwf.mc.base.Util; []

ReceiveReferral java &%
:J

public class BELSRERISISSE00 extends UncompensableTaskMCImpl

& Add unimplemented methods
& Make type 'ReceiveReferral' abstract

-

= Rename in file (Ctrl+2, R

[ Rename in workspace (Al

Click here to add default implementation

3 method(s) to implement:

ca.stfulogic.onf.mcbase.un
Clmpl.action()

ca.stfulogic.owf.mec.base.un
Clmpl.finalize()

ca.stfelogic.owf.me.base.un
Clmpl.initialize()

Fig3.2: Task property file of an atomic task

Table3.1: Tasks, their abstract classes and interfaces for model checking implementation.

Task Type

Abstract Class and Interfaces

Abstract Methods

Atomic Task

UncompensableTaskMClmpl

initialize(), action(), finalize()

AndSplitTask

AndSplitMCImpl

initialize(), action(), finalize()

AndJoinTask

AndJoinMClmpl

initialize(), action(), finalize()

XorSplitTask

XorSplitMClmpl, IMCBranchCondition,
IMCBranchOrder

initialize(), action(), finalize(),
branchCondition(), getBranchOrder()

XorJoinTask

XorJoinMClmpl

initialize(), action(), finalize()

OrSplitTask ORSplitMCImpl, IMCBranchCondition initialize(), action(), finalize(),
branchCondition()
OrloinTask ORJoinMCImpl initialize(), action(), finalize()

LoopSplitTask

LoopSplitMClmpl, IMCBranchCondition,
IMCBranchOrder

initialize(), action(), finalize(),
branchCondition(), getBranchOrder()

LoopJoinTask

LoopJoinMCIimpl

initialize(), action(), finalize()

CompensableTask

CompensableTaskMClimpl

initialize(), action(), finalize(),
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abortlnitialize(), abort(), abortFinalize()

ParallelSplitTask

ParallelSplitMCImpl

initialize(), action(), finalize(),
abortlnitialize(), abort(), abortFinalize()

ParallelJoinTask

ParallelJoinMClmpl

initialize(), action(), finalize(),
abortlnitialize(), abort(), abortFinalize()

InternalChoieSplitTask

InternalChoiceSplitMCImpl,
IMCBranchCondition

initialize(), action(), finalize(),
abortlnitialize(), abort(), abortFinalize(),
branchCondition()

InternalChoiceloinTask

InternalChoiceJoinMClmpl

initialize(), action(), finalize(),
abortlnitialize(), abort(), abortFinalize()

SpeculativeSplitTask

SpeculativeChoiceSplitMClmpl

initialize(), action(), finalize(),
abortlnitialize(), abort(), abortFinalize()

SpeculativeloinTask

SpeculativeChoiceloinMClmpl

initialize(), action(), finalize(),
abortlnitialize(), abort(), abortFinalize()

AlternativeSplitTask

AlternativeSplitMCimpl, IMCBranchOrder

initialize(), action(), finalize(),
abortlnitialize(), abort(), abortFinalize(),
getBranchOrder()

AlternativeloinTask

AlternativeJoinMCimpl

initialize(), action(), finalize(),
abortlnitialize(), abort(), abortFinalize()

BackwardHandlerTask

BackwardHandlerMClmpl

initialize(), action(), finalize()

ForwardHandlerTask

ForwardHandlerMClimpl

initialize(), action(), finalize(),
abortlnitialize(), abort(), abortFinalize()

Programmable
Compensation Task

ProgrammableCompensationMCIimpl

initialize(), action(), finalize()
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More about task property file

Variable Declaration
There are two types of variables in DiVinE in terms of visibility.

i) Global Variables
i) Local Variables

If you want to use an entity bean in a task property file, you have to declare a variable for that
as class attribute; this variable will be translated to DiVinE as global variable. If you want to use
a local variable, you need to declare it in the task property class as class attribute with primitive
data type.

Entity beans will be translated as Global Variable. On the other hand
variables declared as primitive data type will be translated as Local
Variable in a DiVinE process.

public class ReceiveReferral extends UncompensableTaskMCTImpl

Example .

ReferralInfoDTO referrall:;
int age;

@Cverride

public wvoid action() {

A1t m—rrErm e T aterd methad =k

Fig3.3: Variable declaration in task property file

Fig3.3 shows an example. In this example referralA will be declared as global variable in DiVinE
and in any other task property file, if you use the same name they will refer to this variable. On
the other hand age is declared as primitive data type, it will be translated to a local variable of

DiVinE process.
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NOVA Workflow translator will not translate the whole entity bean; it will
read the statements of the property files and will translate only those
properties of entity bean that is used. For example if patient’s Name is
not used in the property file, it will not be translated to DiVinE.

Table3.2: Different statements of java data access and corresponding DiVinE variables.

Java Data Access

DiVinE variable

referralA.setAge(30);

/*age is an attribute of class ReferrallnfoDTO, and
referralA is a variable of type ReferralinfoDTO */

Int referralA_age;

referralA.getAddress().setRoadNumber(55);

/* address is a class attribute of ReferralinfoDTO. The
data type of address is Address class. roadNumber is a
property of Address class */

int referralA_address_roadNumber;

referralA.getContacts(1).getAddress().getLocation();

/* The data type of contacts is List, and this is a property
of class ReferralinfoDTO */

int referralA_contacts_Element_1_address_location;

Data abstraction

NOVA Workflow ships with a Util class which has a method getNonDeterministicData(). Use
this method whenever you need to mention some non-deterministic values for any variable.

The signature of the method is given below:

public static Object getNonDeterministicData(Object[] values)
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public class ReceiwveReferral extends UncompensableTaskMCImpl
{

ReferralInfoDTC referrall:

int age;

@Override

public void initialize() {

age = (Integer)Util.getNonDeterministicData(new Integer[]{20,30,40,50,60}):

Fig3.4: Syntax for assigning non-deterministic data

For an integer the value range is -32768 to +32767. For model checking if we
allow having each value, there will be a huge state explosion which will make
impossible to check a model. Using sample values for each of the class will solve
this problem.

Limited number of Java syntax is allowed in task property file. As this file will be translated to

the input language of a model checker, not all java syntax is supported. Below is a list of syntax

allowed for different methods.

Method Name

Allowed Syntax

initialize(),
abortlnitialize()

localVar = (Integer)Util.getNonDeterministicData(new Integer[1{1,2,..});
localVar = (Long)Util.getNonDeterministicData(new Long[]{1,2,..});

localVar = (Byte)Util.getNonDeterministicData(new byte[l{1,2,..});

localVar = (Boolean)Util.getNonDeterministicData(new Booelan[]{true,false});
localVar = globalVar.getAttribute();

localVar = globalVar.getAggregateProperty().getAttribute();

localVar = globalVar.getListAttribute().get(index);

localVar = globalVar.getListAttribute().get(index).getAttribute();
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action(), abort()

Assignment statements using local variables and numbers. Assignment statements can
contain:

= Numbers, true, false

= Parenthesis: (,)

= Variable identifiers

=  Unary operators ()

= Binary operators (|, A, &, ==, |5, <, <=, >, >=,>>,<<, -, +, /, *, %)

finalize(),
abortFinalize()

globalVar.setAttribute(localVar);
globalVar.getAggregateProperty().setAttribute(localVar);
globalVar.getListAttribute().set(index, localVar);

globalVar.getListAttribute().get(index).setAttribute(localVar);

branchCondition

(int branchNumber)

if( branchNumber ==1)

return Boolean_Expression;
else if( branchNumber == 2)

return Boolean_Expression;
else

return Boolean_Expression;

Boolean expressions can be written using local variables and numbers. The statements
can contain:

= Numbers, true, false

= Parenthesis: (,)

=  Variable identifiers

= Unary operators ()

=  Binary operators (|, A, &, ==, |5, <, <=, >, >=,>>, <<, -, +, /, *, %)

getBranchOrder

(int branchNumber)

if( branchNumber ==1)
return 2;
else if( branchNumber == 2)

return 1;
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else

return 3;

Translation Principle

NOVA WorkFlow translator will translate each of the task by reading the workflow model and
its properties file. If a task does not have any property file, only its flow will be translated to
DiVinE. Each task will be translated to a DiVinE process. In the translation, initialize() method
will be translated first in the process transition, then action() and at last finalize() method. The
conditions specified in the branchCondition() will be translated as guard statement (pre-
condition of a transition) of DiVinE process transition. getBranchOrder() method will be used to
correctly translate the order of execution of the branches.

Review Branch Order and Condition

To review the branch condition mentioned in the task property file, select the task, and open
Task Property Settings (see Fig2.7). Click Next to view the dialog.
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What you will see

Task Properties
Review your branch order and guard
conditions

ADMISS]

Branch Mumber Order Guard Condition

Branch1 1 decision ==

Branch 2 2 true

REFUSE

@

Fig3.5: Review branch condition and order

Only the task that implement either IMCBranchCondition or
IMCBranchOrder interface or both will have this dialog to review. See

Table3.1 for details.

Translate the model

After writing all necessary task property files for your workflow click on Translate to DiVinE tool
from Workflow Components view. A file named translate.dve will be generated and stored in

your workflow package. Use this file to verify your properties in DiVinE.
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Where you will find “) Waorkflow Components &3 - O
-

% iR €9

s

l:l Translate to DVE |‘k

Fig3.6: Translate to DiVinE tool

If you don’t see any code in the translate.dve file double check that you
have a Workflow present with Root Net = True. NOVA WorkFlow translator
will start the translation from Root net.

Tips,

How to do the Reduction

NOVA WorkFlow translator ships with a reduction algorithm which can read LTL (Linear
Temporal Logic) property and reduce the workflow model before doing the translation. To do
this reduction write your property file and name it Itl.property, store it in your workflow
package. Now if you run the translation tool, the translation will be done after applying the

reduction algorithm.
Syntax for Writing LTL property File

NOVA WorkFlow translator will read the #define statements of your LTL property file. If can
mention any task state as a property. To do this use the following syntax:

_WorkflowName_TaskName_State

State can be either Successful, or Abort, or Failed. To mention about the task state use SUC,
ABT, FAIL for Successful, Abort and Failed accordingly.
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When you mention task state as a property in your LTL property file, be
careful about the underscore characters. There is a leading underscore
before the workflow name.

Example #define patient_appropriate (referralA_admissionDecision == 1)
#define registration_done (_Overall_Registration_SUC > 0)

#property write some property here

31| Page NOVA WorkFlow 0.1



NOVA

WorkFlow

CHAPTER 4
USING THE WORKFLOW ENGINE

NOVA WorkFlow engine is a flexible workflow engine developed in the Spring & Hibernate
framework. You can use the engine simply as a library. You can also get a custom made
workflow management system by creating a client Ul communicating with the engine, which
can run with any web application server.

Configure your project

You have to include spring and hibernate jar files to the project. If you are a J2EE expert, you
can safely jump to the next section. Below is a list of jar files you have to add in your project
build path. Download required jar files from http://www.springsource.org/download and

http://www.hibernate.org/downloads.html

Y

activation.jar
antlr-2.7.6.jar
aopalliance.jar

Required jars

cglib-nodep-2.1.jar
commons-collections-3.1.jar
commons-discovery-0.2.jar
commons-logging-1.0.4.jar
dom4j-1.6.1.jar
hibernate2.jar
javassist-3.9.0.GA. jar
jaxrpc.jar

jstl.jar

jta-1.1.jar

jta.jar

log4j-1.2.9.jar
mysql-connector-java-3.0.15-ga-bin.jar

YVVYVVVVVYYVYVVVYVYYVYVYVYYVY

saaj.jar
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slf4j-api-1.5.8.jar
spring-aop.jar
spring-beans.dtd
spring-beans.jar
spring-context.jar
spring-core.jar
spring-dao.jar
spring-hibernate.jar
spring-jdbc.jar
spring-mock.jar
spring-orm.jar
spring-remoting.jar
spring-support.jar
spring-web.jar
spring-webmuvc.jar
spring.jar
spring.vm

YVVVVVVYVYVYVVVVYVYVYVYVVYVYYVYY

standard.jar
wsdl4j-1.5.1.jar

A\

To add the jar files in your build path, paste them into your 4ib’ directory. Select the jars from
eclipse editor, right click on them and select Build Path -> Add to Build Path.

Generate service classes
Click on Create Service Class tool from your Workflow Components view.

Where you will find “) Workflow Components &3 =0

=

e §HicX€d

s

_I Create Java Service Classes h

Figd.1: Tool for generating Service Class
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For each of the task of your workflow a service class will be generated. Some hibernate
mapping files; an applicationContext.xml file will be generated that is required for the
execution of workflow engine. A clientApplicationContext.xml will be generated that you can
use for your client application development. Most of the Service classes have default
implementation; some service classes will need one or two methods to be implemented by the
application developer (i.e., getBranchCondition(), isManual() ).

What you will see f& Package Explorer 3 ?g Hierarchy = 0O

=k
Eﬁ healthcare
2 src
B pc
|=] ewf.property
Y Overall.owf
f& pc.conf
¥| applicationContext.xml
%] clientApplicationContext.xml
| Instancelnfo.hbm.xml
K| Wlnstance.hbrm.ml
JH pc.entity
B po.Overall
i po.Overall.service

[37 Overall_JOIN_7 java

411 Overall_OutputCondition.java
] Overall_Patient_Appropriatejava
[3] Overall_Receive Referral.java

[J] Overall_Refusejava

[J] Overall_Registration,java

4] Overall_Startjava

B pe.util

[7] Constantsjava
Fig4.2: An Example scenario

Every Service class extends abstractTask and depending on the type of task, generated service
classes will implement some Interfaces.

Table4.1 Task types and their Implemented Interfaces

Task Type Interfaces Abstract Methods

Atomic Task Actioninterface action()
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AndSplitTask

ActionInterface

action()

AndJoinTask

ActionInterface

action()

XorSplitTask

ActionInterface, IBranchCondition

action(), getBranchCondition()

XorJoinTask

ActionInterface

action()

OrSplitTask

ActionInterface, IBranchCondition

action(), getBranchCondition()

OrJoinTask

ActionInterface

action()

LoopSplitTask

ActionInterface, IBranchCondition

action(), getBranchCondition()

LooplJoinTask

ActionInterface

action()

CompensableTask

ActionInterface, Abortinterface, Faillnterface

action(), abort(), fail()

ParallelSplitTask

Actioninterface, Abortinterface, Faillnterface

action(), abort(), fail()

ParallelJoinTask

Actioninterface, Abortinterface, Faillnterface

action(), abort(), fail()

InternalChoieSplitTask

ActionInterface, Abortinterface,
Faillnterface, IBranchCondition

action(), abort(), fail(),
getBranchCondition()

InternalChoiceloinTask

Actioninterface, Abortinterface, Faillnterface

action(), abort(), fail()

SpeculativeSplitTask

Actioninterface, Abortinterface, Faillnterface

action(), abort(), fail()

SpeculativeloinTask

ActionInterface, Abortinterface, Faillnterface

action(), abort(), fail()

AlternativeSplitTask

ActionInterface, Abortinterface, Faillnterface

action(), abort(), fail()

AlternativeloinTask

Actioninterface, Abortinterface, Faillnterface

action(), abort(), fail()

BackwardHandlerTask

Actioninterface, Abortinterface, Faillnterface

Initialize(), action(), finalize()

ForwardHandlerTask

ActionInterface, Abortinterface, Faillnterface

action(), abort(), fail()

Programmable
Compensation Task

ActionInterface, Abortinterface, Faillnterface

action(), abort(), fail()
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How to work with the service classes

There are two ways to work with the workflow service classes.

i) Extend service classes
i) Invoke services from outside

Option (i) is suitable for you if you want to use spring for your application development and
option (ii) is suitable for you if you just don’t want to use spring for application development.

Extend service classes

Extend a service class (generated by NOVA WorkFlow) and implement your business logic. Just
after completing your actual work, invoke super.action() method to inform the engine that the
work is accomplished. NOVA WorkFlow engine will update the task status. When you are
invoking super.action() method you have to supply the instanceld as parameter. To know about
instanceld see Workflow Engine Service section.

You have to change the service bean tag in applicationContext.xml.
Configure your bean by replacing the Service Class name in the
applicationContext.xml file. You need to replace the class name and add
your bean references for your service bean (see Fig4.4).

Example

public class AppointmentServiceImpl extends Overall_ﬂppointment|implements IAppointmentService{

private IippointmentDac appointmentDao; \‘ Extendjng NOVA WvorkFlo“r Ser\-'ice class

private IPhysicianService physicianService;

public AppointmentDT( saveAppointment (AppointmentDTC appointmentInfo) throws IlligalCperationException {
ff{ walidate physician
if({ physicianService.findPhysicianInfoById (appointmentInfo.getPhysicianld() == nnll)
throw new IlligalCperationException("Physician id : " + appointmentInfo.getPhysicianId() + " does not

appointmentDac.saveEntity (appointmentInfo)
action (appointmentInfo.getInstanceld()) |
return appointmentInfo; \\\

Invoking super.action() after actual work

Figd.3: An example of Service class extension
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<bean id="Overall Appointment" class="pc.Overall.service.impl.AppointmentServiceImpl"s>
rty name="workflovEngineSsrvice"»<ref local="workflovEnginsScsrvice"/></propertys>

v name="gppointmentDao™»<ref local="appointmentDao"/>

Figd.4 Service Bean tag of applicationContext.xml|

Invoke services from outside

To invoke a NOVA WorkFlow service bean from outside expose the bean interfaces by
RMI/Httpinvoker/WebService. After completing the actual work of a task, invoke the action()
or abort() or fail() method from outside through the interface. NOVA WorkFlow engine will
update the task accordingly.

Configure a service for Automatic or Manual execution

It is possible to configure a NOVA WorkFlow service for automatic/manual execution. If a task
is configured for automatic execution, the engine will invoke the action() method automatically
instead of waiting for its action() method to be invoked from the application. On the other
hand if a service is configured for manual execution, the engine will wait for the invocation of
its action() method. A method isManual() is declared in abstractTask class and the default
implementation of isManual() method returns false (means automatic execution). You can
override this method and configure it for manual execution.

Example public class PatientRegistrationServiceImpl extends Overall Intake -
private IPatientRegistrationDac patientRegistrationDao;
public boolean isManual ()

{
return true;

Figd.5: Configure service for manual execution
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The automatic/manual configuration for service execution is same
for action(), abort() and fail() methods.

How to implement IBranchCondition Interface

NOVA WorkFlow engine needs to know about the branch Condition of some split tasks (see
Table4.1). It does not provide any default implementation as it is totally depends on the
application. The interface has only one method and the signature is given below:

public interface IBranchCondition {

public boolean getBranchCondition(long instanceld, int branchMumber);

Fig4.6: IBranchCondition Interface

You can write any java statement in the method while implementing. Typically you will need to
do some database searching or invoking some service to know about the conditions. The
workflow engine will invoke this method with instanceld and branchNumber to know which
branch to execute.
public boolean getBranchCondition(long instanceld, int brNo) {
Example ReferralInfoDlTC referrallInfo = receiveReferralService.findReferralInfoByInstanceld (instanceld);
if (brNo == 1)
i
if (referrallnfo.getAdmissionDecision () == ReferralInfoDTC.PATIENT APPROPRIATE
return true;
else

return false:

else
return true;

Figd.7: Example of getBranchCondition() implementation

NOVA WorkFlow Engine will get the branch orders from the task
properties file that you configured for property verification. See ‘Review
Branch Order and Condition’ section in previous chapter.
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WorkFlow Engine Service

NOVA WorkFlow engine provides an interface IWorkFlowEngineService using which an
application can be easily build with workflow support. The methods are described in Table 4.2

public interface IWorkflowEngineService {

public WfInstance createNewWorkflowInstance (WfInstance newlnstance);
public WfInstance getlInstance(long id);
public List<WfInstance> getAllActivelInstances();

public List<InstanceInfo> getAvailableMethods (WfInstance thelnstance);
public List<InstanceInfo> getAvailableMethods (Long instanceld, String taskId);

Table4.2 Description of the methods of IWorkflowEngineService

Method Name Functionality

createNewWorkflowInstance To create a new workflow instance use this method. This method inserts a new
record in table Wflnstance and generates a unique id for the newly created instance.

getinstance To know details about an instance this method can be used.
getAllActivelnstances This method returns all Active instances
getAvailableMethods There are two overload methods:

i) Takes a workflow instance and returns all Instancelnfo containing taskld and
available methods of the tasks

ii) Takes an instanceld and taskld as parameter and returns all available
methods for the task

Attributes of class Instancelnfo is shown here:

private Long id;

private Long instanceld;
private String taskId;

private String workflowName;
private String varName;

private Integer value;

private String availableMethod;
private String actor;
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Table4.3 shows all possible values of availableMethod. Your application will determine the
available operation by these constants:

Table4.3 Possible values of availableMethod and their meaning

Value Meaning

ACTION Task is active for execution

ABORT Task is enable for abort operation

FAIL Task need to perform fail operation

CMP_ACTION The composite task is active for execution

CMP_ABORT The subnet tasks aborted, the composite task needs to perform abort operation

How to get the WorkFlow Engine Service

The workflow engine is deployed in applicationContext.xml as a service. You can expose the
interface using RMI/HttpInvoker/WebService or any other methods. An example of exposing
the service using RMI is shown here:

<bean id="workflowEngineDao" class="ca.stfx.logic.cwf.engine.service.impl.ForkflovEngineDaoImpl ">
<property name="ssssionFactory"s<ref local="ssssionFactorvy"/></property>
</bean>

<bean id="workflovEnginsServiceTarget” class="ca.stfx.loglc.cwf.engine. service. impl.ForkflovEngineServiceImpl ">
<property name="workflowEngineDao"»<ref local="workflowEngineDao"/></property
</bean>

<bean id="workflovEnginsService" class="org.springframevork.transaction.interceptor.TransactionProxyvFactorvBesan">
<property name="transactionManager"»><ref local="transactionMsnager"/></property>

wame="target"><ref local="workflowEngineSsrviceTarget"/></property>

wame="transactiondttributes">

< name="s=rvice" ref="workflovEngineSsrvice"/>

<pr name="servicelnterface" value="ca.stfx.logic.cwf.=sngine. service. IForkflovEngineServics"/>
<!—— defaults to 1099 —->

<property name="reglstryPort” valus="1788"/>

</bean>

Fig4.8: Exposing WorkFlow Engine Service using RMI
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How to Deploy

Deploy the service classes, entity beans, hibernate mapping files and application context in your
application server or web container. You have to include spring, hibernate jar files in the web
application and additionally cwf.jar file.

The default applicationContext.xml that is generated by NOVA WorkFlow
Service class generation tool includes default database information. You
have to edit the information to configure your database.

Tips,
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CHAPTER 5

DEMO

A demo application is available in CLI website which shows the functionalities of NOVA
WorkFlow. You can download it from http://logic.stfx.ca/novaflow/pc_demo.html. The demo

contains two projects- i) Server side application including workflows, ii) client side application
which is an eclipse RCP application. The webapp directory contains all required files that you
will need to deploy in your web container. One could use other technologies like
JSP/Struts/JSF/Others for the client side application.

Use Case Scenario

PC_Demo application is a small workflow of healthcare system. A patient is referred by
community care to palliative care program, where s/he consults with a physician and get
registered to the program. Once registered a team consisting of formal and informal caregiver
is built for the patient. For this example our use-case is as follows

% A patient will be referred to Palliative-Care program.

% An appointment will be set with a physician for the patient.

¢ Physician will consult with the patient.

¢ Physician will decide if the patient is appropriate for the program or not
% If the patient is not appropriate s/he will be Refused with an explanation
% Otherwise the patient will be registered.

< Ateam will be made with different caregivers for the registered patient.
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Workflows in pc_demo

There are two workflows in pc_demo named Ovreall and TeamBuilding. Overall is the Root net
and TeamBuilding is a true compensable net. Fig5.1 and 5.2 shows the workflow models.

“) Overall.owf 27 *) TeamnBuilding.cwf

INTAKE

BUILDIMNG DELIVERY

RECEIVE  APPQINTMENT  COMSULT PATIEMT
REFERRAL VALID

»
L
EXPLANATION

Fig5.1 Overall workflow of pc_demo

) Overall.owf “) TeamBuilding.cwf 2

INFORMAL
CAREGIVER2

MOVETO
HOSPITAL

Tl
INFORMAL
CAREGIVER

FAMILY
PHYSICIAN

Fig5.2 TeamBuilding workflow of pc_demo
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How to run

Create a database from the script provided in the demo_app, or you can create tables using
ant-script and the hibernate mapping files. Run your database server and provide the
information to the applicationContext.xml. Deploy the webapp to your web container.

To start your client application, import the project into eclipse. You can either launch the
application from eclipse or you can build it as RCP product then run.

To build/run the pc_demo client application, make sure that your eclipse
installation has RCP development environment.

H emo (=] B [
What you will see fIF’C:I = e
ile Help
W+ B4
4 = Overall W Wilnstance 52 ]

—;P,q Receive Referral

" 5 Create a new workflow Instance!
Ta. Appointment

After creating a new workflow instance you will be able to
& Consultation execute the tasks of the workflow.

1 Intak
Ry B Date: 18/7,/2010
4 [~ Team Building

B Find Home Service Your name:
}& Move to Hospital
# Informal Caregiver
# Informal Caregiver2
74 Family Physician
w. PC Physician

4 [= Resource Mgmt
W Workflow Instance
B WorkList
T Register Physician

Comment:

“ Home Service

Create

Fig5.3: pc_demo client application

Play with the application

Create a workflow instance. The engine will persist a new workflow instance to database. To
view the available tasks of an instance open WorkList view in your client application. It will
show all active instances in a drop down. Select an instance from the drop down to see the
active tasks of the instance.
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. [ T = | ] |
What you will see | 2>
ile Help
W < B4
[ Owverall \“ Wilnstance | J) Worklist 53 s

Receive Referral
‘_E AEC en.;e it Select an instance from the drop down.
& Appointment Available workitems will be displayed in the list
g Consultation

% Intake Active Instance:
== Team Building
J® Find Home Service Index Task Name Operation  Operation Type
& Move to Hospital 1 Overall Receive Referral  ACTION Manual
# Informal Caregiver
# Informal Caregiver?
74 Family Physician
w. PC Physician
= Resource Mgmt
W Workflow Instance
B WorkList
 Register Physician

&0 Home Service

Fig5.4: WorkList view of pc_demo client application

If you select a task from the worklist, its view (form) will be opened where you can insert
information and execute the task.

. PC Demo N
What you will see .. ...
W =
= Overall [§ Whinstance | 8 Workdist [-bc Referral £3 |
% Receive Referral

)
Tl Appointment
& Consultation

A

% Intake
- 5 ;u;ding Active Instance:

 Find Home Service

Receive Referral for patient
Date: 18/7/2010

A Move to Hospital M August, 2010 »
Informal Caregi
R Ol e Sun Mon Tue Wed Thu Fri Sat
# Informal Caregiver2 B A % h
& Family Physician Referral Date: 12 3 4 5 6 7
. PCPhyzician 8 9 10 11 12 13 14
[ Resource Mgmt L 16 L 20 a Patient Marme:
Y Workflow Instance 55 53 g Zf Zg 2; 23
3 WorkList ok
2 Register Physician Referred By:
: DOB:
9 Home Service Referral Source: [¥] CONTINUING CARE
[7] CONSULT TEAM Sex @ MALE
Type of Referral: [STAT () FEMALE
Metastuses:
Address:
Telephone:

Referred To: PHYSICIAN L

Primary Diagnosis:
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Fig5.5: Referral form of pc_demo client application

Some tasks are not part of this patient’s workflow, for example registering a physician or home
service. There can be a different workflow for managing the resources, but in this demo_app its
simply done by accessing PhysicianService service bean.
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